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Bevezeto

Kedves Hallgatok!

Ezt a segédletet azért készitettlik Szamotokra, hogy gyorsan és kdnnyen megismerkedhessetek az
OpenTrack vasuti szimulaciés program alapvetd tulajdonsagaival, miikodésével. A segédletet ugy
allitottuk 0©ssze, hogy ennek segitségével felépithet6 egy tetszGleges vonalszakasz, amelyek
allomasokat és nyiltvonali szakaszokat is tartalmaz. A gyakorlati dtmutatd hasznalataval megérthetjik,
hogyan lehet pdlyat épiteni a programban, vaganyutakat létrehozni, és ezek alapjan a felvett
menetrendet szimulalni, illetve a kapott eredményeket kiértékelni.

A program hasznalata el6tt fontos, hogy végigolvassuk az angol nyelv{ Utmutatot is, amely részletesen
leirja azokat a funkcidkat, amelyekkel a program rendelkezik, és megértsiik azt, hogy a szimuldlni kivant
haldzatunkat milyen elemekbdl épithetjik fel. A gyakorlati foglalkozas el6tt — a gyors, hatékony
munkavégzés miatt — a kézikényv (OpenTrack.Manual _E.1.6.pdf, angol nyelv(i) atolvasasa ezért
nagyon ajanlott és célszerl. E mellett tamaszkodunk arra a tudasra is, amelyet kordbban, valamint az
egyetemen, illetve a Vasuti irdnyitd és kommunikaciés rendszerek I-Il. tantargyak sordan magatokéva
tettetek, hiszen a program hasznalatdhoz a vasuti kozlekedési rendszer, és a vasuti kozlekedés
alapelveinek ismerete elengedhetetlen.

OPENSTRACK

Simulation of Railway Networks
Version 1.6

Ezt a programot Magyarorszag mas egyetemén és tobb mérnoki tervez8irodaban is hasznaljak, ezért a
program ismerete hozzajarul szakmai fejlédésetekhez, és emellett egy korszer(, hatékony eszkozt ad
a kezetekbe, amelyet a késGbbiekben akar kamatoztatni is tudtok!

Itt szeretnénk koszonetet mondani Laszl6 Csaba Tibornak (tervezémérndk, FOMTERV Zrt.) aki
munkdnkat nagyban segitette, és hasznos tanacsokkal latott el minket a program hasznalataval
kapcsolatban.

A programrol bévebb informdacidk, példak, bemutatok megtaldlhatok a cég honlapjan, amely a
http://www.opentrack.ch/ weboldalon érhettek el, tobbek k6zott angol és német nyelven, ezen kivil

érdemes a honlapon |évé projektekbe is beletekinteni.
Tovabbi kérdés esetén keressetek Benniinket bizalommal!

Eredményes munkat kivanunk: a Szerz6k


http://www.opentrack.ch/

-A szimulaciorol

A szimulaciénak mindig célja van. A célnak megfelel6en kell a megépitett vagy meg nem épitett
infrastruktirat vizsgalni, azon az aktudlis vagy tervezett menetrendet elemezi. Nagyon sok bemené
paramétert kell figyelembe venni, és még igy is sokat csak becsiilni lehet. Bizonyos paraméterek
megvaltozasa elhanyagolhatdan kis mértékben mddositja az eredményt, mig masok igen nagy szerepet
jatszhatnak a modellezésben. Példaul a vontatéjarmdvek aktudlis mlszaki allapota akar percekkel
megnovelheti a menetid6t. Ezen kiviil az utasok viselkedésének modellezése nehézkes, egy kerékparos
csoport az allomasi tartdézkodasi idSt jelent6sen megnydjthatja, ami szintén felborithatja a
menetrendet. Ezek egylttes figyelembe vétele még nehezebb, de bekodvetkezési valdszinlségiik a
gyakorlatban nem elhanyagolhatéan alacsony. Ezen bizonytalansagok miatt 100%-ban pontos
szimulaciét (ami a valdsagot 100%-ban lefedi) nem fogunk tudni futtatni, de j6 kozelitéssel az
eredmények elfogadhatdak lesznek.

Fontos, hogy csak akkor kapunk pontosabb képet, ha a szimulaciot tobbszor is lefuttatjuk, az egyes
szimuldcidk kozott pedig bizonyos paramétereket megvaltoztatunk. Azt, hogy milyen tipusu
vizsgalatokra kell a szimulaciot elvégezni, azt a szimulacid célja hatarozza meg.

A legegyszerlibb egy mar meglév6 vonalszakasz elemzése, hiszen az infrastruktura és jarm(i adatok
jelent6s része rendelkezésre all. Itt konnyebb egy zavarérzékenységi vizsgalat, és a forgalomra
gyakorolt hatdsok elemzése.

Mads esetben, egy Uj pdlya tervezésekor sem a pontos infrastruktira adatok, sem a kdzlekedtetni kivant
jarmUvek tulajdonsagai nem feltétlendl alinak rendelkezésre. Az el6zetes szimulacid segitségével
viszont kénnyen megmondhatd, melyek lehetnek kés6bb a szlk keresztmetszetek, hol sziikséges
esetleg tobblet keresztezési lehet6ségek vagy allomasfej elhlizdsok megépitése. Ez nem jelent mast,
mint tobbféle lehetséges forgalmi terv 6sszehasonlitdsat, és a dontéshozatal tAmogatdsat.

A szimuldaciét ezért fontos megtervezni, vagyis megmondani azt, hogy mit akarunk vizsgalni, mit nem
— a hatarfeliileteket minden esetben definialni kell.

Ennek a dokumentumnak az a célja, hogy segitsen azoknak, akik az elsé |épéseket meg szeretnék tenni
a program hasznalatdban, de azt, hogy miért akarunk és mit szimulalni, azt mindig egy adott feladat
fogja eldénteni. Egy vonalszakaszon praktikusan nagyon sokféle forgalmi szituacid is el6fordulhat,
ezért ilyen vizsgdlatot nem lehet végezni. Ezt a program hasznalata el6tt tisztazni kell.



-Fontos informaciok

2.1 A program felépitése, funkcioi

Nézzilk meg roviden, mire alkalmas a program, és milyen alapveté elemekbdl lehet felépiteni a
szimulalni kivant haldézatot!

A program mikodését az 1. dbra szemlélteti.
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1. dbra A program mikodése

A szimulacid lefuttatdsahoz sziikséges:

e avasutiinfrastruktura valamennyi elemének (pl. valtdk, jelzék, allomasok, lassujelek, vontatasi
aladllomasok, fazishatarok, stb.) felvétele a valdsagos pdlyaadatok alapjan,

e a kozlekedtetni kivant jarmUivek ,megépitése” a valdsagos jarmdvek tulajdonsagainak alapjan
és

e akivant menetrend elGallitasa.

A vasuti infrastruktura — szdmunkra rendelkezésre dllé — adatai a mellékelt fdjlokban megtaldlhatdak.
A program helyes miik6déséhez nagyon fontos, hogy a valésagnak megfelel6 infrastruktiurdat (mind a
pdlya mind a jarmiivek tekintetében) épitsiink fel. Eppen ezért egy-egy dllomds megrajzoldsa igen
idbigényes feladat, hiszen minden egyes részletet kiilén-kiilén fel kell rajzolni. A rendelkezésre dllo
adatokat tébb fdjl egyiitt tartalmazza, igy a sziikséges adatok kinyerése nagyon dsszetett, jelentds

o

idérdforditast igényelhet.



A program a kévetkez6 funkcidkat tdmogatja:

o Uzemi miiveletek:

O O O O O

O

Allomasok, nyilt vonali szakaszok kapacitasanak meghatarozasa,
Sz(k keresztmetszetek maghatdrozasa,

Allomasi foglaltsagi id6k meghatarozasa,

Optimalis szerelvényforduld meghatarozasa,

Zavarok hatasanak megallapitasa,

Karbantartasi, feldjitasi munkak tervezése,

vizudlis megjelenités.

e |nfrastruktura:

O

@)

O

O

Kilénboz6 infrastruktira valtozatok részletes értékelése,
Jovbbeli fejlesztések részletes vizsgalata,

Jelzési rendszer tervezésének tamogatasa,

Infrastruktira adatok kezelése.

e Menetrend:

@)

@)

Menetid6 szamitas,
A menetrend konzisztencidjanak megdllapitasa, lehetséges
determinalasa.

e GordilSallomany:

O

O

Szerelvényfordulé meghatarozasa,
GordilSallomany jov6beli igényének meghatarozasa.

A szimulacid kiértékelését az aldbbiak tamogatjak:

e Ut-id6 diagramok,

konfliktushelyzetek

o Allomasi vaganyok foglaltsagi idejét bemutaté diagramok (kvazi tizemi terv),

e Jelentések a zavarokrodl,

e Vonatok menetdiagramija,

e Vontatasi erésziikségletek jelzése,

o Atervezett és a tényleges menetrend 0sszehasonlitdsa.

Ezek a funkcidk és lehet6ségek nagyban tdmogathatnak egy dontés-elGkészitést, legyen szo pdlya

rekonstrukciérél (pl. Szeged — Hodmezbvasarhely Tram-Train) vagy egy Uj vonal megépitését (pl. VO).

A program hasznalatdval a menetrend alapu infrastruktura fejlesztés lehetségessé valik.

2.2 Az alap épitoelemek

A programban un. ,worksheet”-eken (munkalapokon) dolgozhatunk. Egy adott vonalat célszer(ien

tobb ,,worksheet”-bél allitunk 6ssze. Ennek az az oka, hogy igy a szerkesztés kényelmesebb, rdadasul

egy allomdas vagy nyilt vonali szakasz mddositdsakor elegend6 csak azt az egy ,worksheet”-et

szerkeszteni. A ,,worksheet”-ek kdnnyen 6sszekapcsolhatdak, igy lehet6ség van arra is, hogy tobben

dolgozzanak egy projekten, hiszen mindenki megépiti a sajat allomasat, amelyet kés6bb konnyedén

Ossze tudunk kapcsolni. A ,worksheet”-en tudunk rajzolni a , Palette” eszkoztar segitségével, amelyen

6.



valamennyi alap épit6elem megtaldalhatd. A ,Palette”-et a Ctrl+0 billentylkombinacidval tudjuk
el6hivni.

Az alapvet6 épitSkocka a programban az un. ,vertex”. A ,vertex”-ek segitségével tudjuk elkésziteni azt
a grafot, amely a hdldézatunkat alkotja. A grafok csucsai ezek a ,vertex”-ek. A ,vertex”-ekhez tudunk
valtdkat, jelz6ket, allomasokat rendelni. A program un. kettds ,vertex”-et (DVG, double vertex graph)
hasznal, ez kiiléndsen a valték miatt hasznos.

A ,vertex”-eket kotik dssze az élek — ,,edge” -, amelyek irdnyitott élek. Fontos, hogy az élek irdnya a
vonal kezd6pontjatdl a végpontja felé mutasson, hiszen a rendelkezésre allé adatok szelvényhelyes
informdcidkat tartalmaznak, és a vonal kezdGpontja fel6l vannak értelmezve az infrastruktura adatok
is. Egy egyszer( grafot mutat be a 2. dbra.

A program ezen a grafon tud vagdnyutakat értelmezni. A kettGs ,vertex”-ek miatt, a vonat csak ugy
kozlekedhet, hogy minden esetben egy ,,sima nagybetls” helyet egy ugyanolyan bet(s , aposztréfos
hely” kovet. Ezért a lehetséges vaganyutak ezen a grafon AA’ — BB’ — CC’' — DD/, illetve AA’ — BB’ —EE’ —
FF’, amely egy kitérG két szaran valé kozlekedésnek felel meg. Nem lehetséges a C'C — B’ — EE’ utvonal,
hiszen a B’-t csak B kdvetheti (gyakorlatban ez azt jelenti, hogy nem lehet egy kitérén gyok felSl gyok
felé kozlekedni). Ez a DVG el6nye az egyszer( ,vertex”-ekkel szemben.

EE" FF

AA” BB CC DD
2. abra Egyszer( graf

A jelz6k, valték, allomasok mind-mind ,vertex”-ekhez vannak hozzarendelve, ezért fontos hogy a
valdosagnak megfeleléen vegylik fel azokat.

A vaganyutak definialasanak tébb szintje van. A legalacsonyabb szint a ,Route”, amelyet két fGjelz6
kozott értelmeziink. A masodik szinten taldlhaté a ,Path”, amelyet két kijarati jelz6 kozott
értelmeziink. A harmadik szinten taldlhaté az ,ltenerary”, amelyet Path-okbdl épitliink fel. Egy
Itenarery célszer(ien egy vonat teljes haladasi utjat jeloli —kvazi megfelel a menetvonalnak - a
megépitett haldzat teljes hosszan. Az ,ltenerary”’-k segitségével definidlhatunk ,Course”-okat,
amelyek tulajdonképpen egy vonat szerelvényforduléjat adja meg a hdaldzatunkon. A lehetséges
,Route”-ok, ,Path”-ok és ,ltenerary”-k tetsz6legesen hozzarendelhetéek barmely vonathoz, igy ezen
elemek segitségével kdnnyen és gyorsan rendelhetiink utvonalat a vonatainkhoz. A programban
tolatévaganyutak beadllitasa és kezelése is lehetséges, de ebben az Utmutatdéban ezzel nem
foglalkozunk.



Fontos része a programnak a felsGvezeték halézat kiépitése, hiszen a fazishatarokon nincs villamos
vontatas, és ez befolyasolja a jarmUivek menetidejét. A fels6vezetéki haldzat egyszerlien épithet6 ki a
programban.

Az alapelemek segitségével a kovetkezs fejezetekben létrehozunk allomdasokat és nyilt vonali
szakaszokat, majd ezek 6sszekapcsoldsaval létrejon egy teljes vonalszakasz, amelyen a szimulaciot le
lehet futtatni.

Hasznos billenty(ikombinacidk (ezek az ablakok a fels6 menisorbdl is elérhetéek):

o Ctrl+0: Palette eszkoztar

e Ctrl+2: Inspector — valamennyi elem szerkesztéséhez
e  Ctrl+3: Route Inspector (Vaganyutak)

e Ctrl+4: Path Inspector (Utvonalak)

e  Ctrl+5: Itinerary Inspector (Menetvonalak)

e  Ctrl+6: Trains (Szerelvények)

e Ctrl+7: Courses/Service (Vonatok)

e Ctrl+8: Timetable (Menetrend)

e  Ctrl+9: Szimulacio



Blrsjlok

Az OpenTrack az infrastrukturat, a jarmdveket és a vonatkozlekedést leiréd adatokat kiilon fajlokban
tarolja:

- vontatéjarmivek (.depot),

- szerelvények (.trains),

- dllomasnevek (.stations)

- infrastruktira és utvonalak (.opentrack)
- menetvonalak (.dest),

- vonatok (.courses)

- menetrendek (.timetable).

A szimulacié lefuttatasakor az eredményeket egy kiilén mappaba menti a program (OTOutput mappa).

A tanszék csupdn a koOzos vontatdjarmiveket (KJIT.depot), szerelvényeket (KJIT.trains) és
allomasneveket (KJIT.stations) adja ki az egységesség jegyében, ezeket mddositani nem szabad. Az
infrastruktlrat és az Utvonalakat tartalmazd (.opentrack) fajlt mindenki a kiadott feladata alapjan egy
adott vonalszakaszra oOnalléan késziti el. A menetvonalak, vonatok és menetrendek tobb
vonalszakaszra (de csak néhany vonatra) vonatkozéan késziilnek el, egymas (.opentrack) munkait
felhaszndlva. Az ezt kévet6 szimuldciot tobb vonalszakaszra és tobb vonattal futtatjuk le, emiatt az
onalléan elkészitett, menetvonalakat, vonatokat és menetrendeket tartalmazd fajlokat az oktatd
begyd(jti, és azokat egyesiti. A szimuldciét mar az egyesitett fajlok (KJIT.dest, KlIT.courses,
KJIT.timetable) hasznélataval kell lefolytatni.

A kovetkez6 konyvtarszerkezetet (3. abra) hozzuk létre az OT adatbazis file-ban! Az itt szerepld Aliga-
Bélatelep az aktudlis projekt neve! Az OT adatbazis file-ba (4. abra) helyezziik el a k6z6s adatbazisokat
(.depot, .trains, .stations), melyek tartalmat ne modositsuk!

4 .. OT adatbazis

4 . OT Aliga-Belaptelep
OTData

& OTOutput
a ! OTWorksheet

3. dbra A helyes konyvtarszerkezet



e OT Aliga-Bélaptelep 2014.08.18. 11:02 Fajlmappa

w KIT.depot 2014.08.05, 11:49 DEPOT fa)l 10 KB
w | KIIT.stations 2014.08.18,11:22 STATIOMS fa)l 2 KB
w KT trains 2014.08.06, 11:41 TRAINS fajl 11 KB

4., abra Az OT adatbazis file tartalma

Kezdetben hozzuk létre sajat projektiinkben az Ures .courses, .dest és .timetable fajlokat! A
legkdnnyebben ezt Ggy tehetjilk meg, hogy az OpenTrack sajat mappajabdl az alapértelmezetten ires
fajlokat atmasoljuk, majd dtnevezziik. A program sajat mappaja alapértelmezett telepités esetén a
Program Files/OpenTrack V1.7/0OTData Utvonalon érheté e

A .depot, .stations és .trains file-ok a szerveren mar rendelkezésre kell, hogy alljanak az OT adatbazis
file-ban.

A ,worksheet”-eket a sajat OTWorksheet mappdba mentsik majd el, az OTOutput mappa pedig az elsé
szimuldcié lefuttatasdig Gires mappa lesz. Ha ezzel megvagyunk, akkor a be kell dllitani a file-ok helyét
a programban.

Ellen8rizziik az adatbazisok megfelelGségét (Info—> Preferences)! Itt allitsuk be mind a hét fajl elérési
utvonalat, amelyeket el6z6leg mar targyaltunk. Ha ez megtortént, akkor mentsiik el ezt a beallitast
(,set”-et) a ,Save Set as” paranccsal, ezutan ha kés6bb ugyanezekre a fajlokra lesz sziikségiink, akkor
a program ezeket automatikusan be fogja tudni tolteni. Ha a helyes adatbazis struktura a
rendelkezéslinkre all, akkor kezd6dhet a palyaszerkesztés.

10.



BAz infrastruktira megépitése

Az infrastruktira megépitése az els6 feladat. Ez a rész a vaganyhaldzat kiépitésétél a fels6vezetéki
rendszer meghatdrozasaig tart, mikdzben valamennyi pontos infrastruktira adat felvételre kerdil.

Szerkesztés el6tt gondoljuk végig alaposan azt, hogy milyen vonalszakaszt szeretnénk szimuldlni, és ezt
hogyan osztjuk fel ,,worksheet”-ekre. Ez azért fontos, mert kés6bb a , worksheet”-eket 6sszeflizzlik
(Document Set), ezért a ,worksheet”-eknek lesznek k6z6s pontjai. A vonal ,worksheet”-ekre vald
tagolasa egyben egy-egy szakasz elejét és végpontjat is definialja. A tagolast ugy célszer(i elvégezni,
hogy egy munkalapra csak akkora vonalszakaszt vesziink fel, amekkora a képernyénkdén még
kényelmesen szerkeszthetd. A rendelkezésre allo palyaadatok a mellékelt file-okban megtaldlhatdk,
bar haszndlatuk idGigényes, és sokszor kényelmetlen is. Azt, hogy melyik file-bdél milyen informaciot
tudunk kinyerni, a szerkesztés soran, az adott pontndl mutatjuk be részletesen.

4.1 A szerKkesztés elott

Inditsuk el a programot, majd ellenérizziik a kdvetkezé beallitasokat:

1. GyG6zédjunk meg arrdl, hogy a program regisztralva van (Info/Registration: This version of
OpenTrack is licensed). A nem regisztralt program ugyan miikoddéképes, de menteni nem lehet
benne. A szamitdgép Ujratelepitése esetén a régi licenckdd érvényét veszti, erre figyelni kell!

2. A beallitdsoknal (Info/Preferences/Train-Speedtype) 4 vonatsebesség kategdria legyen:
Személyvonat, Motorvonat, Tehervonat, Ro-La. A rajzbeallitdsoknal ,Show switch position”, a
»Toggle Windows”, a szdmitdsoknal pedig ,Use switch time and Route reservation time”
legyen bejeldlve.

Egy-egy allomas elkészitése (.opentrack fajl) kiilon-kiilén munkalapokon megfeleld lehet, ugyanis a
szimulacié futtatdsakor meg lehet nyitni tébb munkalapot, amelyeken az allomasok 6ssze vannak
flizve, majd ezeket ,Document Set”-ként el lehet menteni, igy legktzelebbi alkalommal mar a kész
teljes palyat tudjuk egyben megnyitni.

4.2 Palyaszerkesztés

Az allomasi helyszinrajzokat az dtvonalkdnyvek tartalmazzak, amelyek megtaldlhatéak:
OTmunkaanyagok/Helyszinrajzok, Vonali abrdk mappéban, vonal szerint rendezve. A nyilt vonalakra
vonatkozd vonali dbrakat (térkozjelzék elhelyezkedése) pedig az OTmunkaanyagok/Kézlekedési
hatdrozmdnyok file tartalmazza terileti bontasban. A hatdarozmanyok 7. tablazata tartalmazza a
térkozjelz6k pontos helyét. A felsGvezetéki haldzatra (fazishatarok, alallomasok) vonatkozé adatokat
az OTmunkaanyagkok/Felsévezeték file tartalmazza. Ugyelni kell az aldllomasok megfelels
elnevezésére, és a transzformatorok taplalasi iranyara.

Egyvaganyu vasutvonal esetén célszer( a szimulalni kivdnt vasutvonalat dllomastél allomasig felvenni.
Ennek az az oka, hogy a szimulacional a vonatok csak dllomasokon tudnak megjelenni és feloszlani.
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Miutdn a fenti el6késziileteket megtettiik, és pontosan rogzitettiik a megrajzolni kivant szakaszt,

elkezdhetjiik a palyaszerkesztést.

1.

10.

11.

12.

Jelenitsik meg a szerkesztést segit6 halot: Grid=10px (Format—>Grid). Id6nként sajnos ez
eltlinik, ekkor egy frissités (Refresh) segithet (Ctrl+R).

Rajzolni a bal alsé sarokba érdemes (mindig a vonal kezdGpontja fel6l kezdve), mert a
Format—>Document Setup meniiben, ahol a munkalap méretét lehet beallitani, onnan szamitja
a megadott pixeleket (egyébként kénnyen eltlinhet a palyank). A szerkesztés végén az
Autoscale gombbal a kész palyankhoz hozzaigazitjuk a munkalapot, és igy mentjiik el a palyat.
A szerkesztés kényelmesen 200% nagyitasban (munkalapon a jobb alsé sarokban allithatd)
nagy pontok megjelenitésével (Format->Show Big Vertices) végezhetd, a végén a pontokat kis
méretben érdemes megjeleniteni, mert nincs jelentdséglik, és csokken a zsufoltsag.

Az élek iranya mindig KP>VP irdnyu legyen (a lejtviszonyok miatt ez fontos). Az élek iranya
megjelenithetd (Format—>Show Directions of Edges).

Pont (,Vertex”) beszurhatd/torélheté mar meglévé élre/élrdl: SHIFT lenyomasa mellett.
ElGszor a topoldgidt vesszik fol az [allomasi helyszinrajzok] és [részletes vonali abrdk] alapjan.
Err6l km adatot nem kell leolvasni, pusztdn a topoldgidara van sziikség (valtok, jelz6k
elhelyezkedésére), illetve a jelz6k és fogaddvaganyok szdmozasara. A sorompdkat nem kell
folvenni, a szimuldcidt nem befolydsoljak. Az dllomast, megallohelyet a kiadott sablon alapjan
kell megrajzolni. Erdemes el6bb tébb helyet hagyni a pontok kdzott, mert a tovabbiakban tébb
pontot is be kell majd szdrni a mar meglévé élekre. A szerkesztés végén kell Ugy igazitani a
pontokat, hogy ugy nézzen ki az allomas, mint a kiadott sablon. A peronok szine:
Pantone—>System—>,,controlShadowColor”.

A valték alldsa az ,Inspector” ablakban a ,Changes” gombra kattintva megvaltoztathato.
Ugyelni kell a helyes alapallasra! Ha egy Uj pontot szdrunk be egy meglévé valté mellé, a valtd
alapdllasat a program automatikusan megvaltoztathatja!

Keresztezésnél a keresztezési részt alkoto két élt a ,,Functions=>Merge elements” paranccsal
egyesiteni kell egyetlen elemmé (ugyanaz legyen az element azonositdjuk), igy egyszerre
valtozik az allapotuk. (Ez ellenérizhetd az ,,Inspector” ablakban a ,State” gombra kattintgatva.)
Egyébként a program szintben elkiilonilének tekinti az éleket.

Jelz6knél elGszor csak ki kell valasztani a tipust (és f6jelz6 esetén azt, hogy
bejarati/kijarati/térkozjelz6). Kétvaganyu palya forgalmi kitérgjét fedezd jelzéket kijarati
jelzének kell tekinteni, ez az Gtvonalaknal fog szamitani.

Kijarati jelz6k esetén jeldljik be a , Keep closed for Station Stops” opciodt. Ezzel azt érjiik el,
hogy az dllomdson menetrend szerint megdllé vonatnak csak kézvetlenil az induldsi id6 eldtt
fog szabadra allni a kijarati jelz6. Ezen opcid bejeldlése nélkil a vonatmegel6zések nem
lehetségesek.

Miutan folvettik valamennyi jelz6t, kijelolink tobb ugyanolyan jelz6t (SHIFT lenyomasa
mellett), és azokra egyszerre allitjuk be a kiadhatd sebességjelzéseket. Ezek utan lehet az
egyedi dolgokat beallitani (pl. 80-as sebesség jelzése).

Az dllomasok, megalléhelyek minden fogaddvaganyan el kell helyezni egy-egy allomasi pontot
(5. abra). Valamennyi pont km adata ugyanaz: az e-HUSZ
(http://www.vpe.hu/takt/vonal lista.php) vasutvonalaindl a megfelel6t kivalasztva az

allomashoz vagy megalléhoz tartozo ,tdv [km]” adat alapjan kell félvenni. Sok esetben sajnos

12.


http://www.vpe.hu/takt/vonal_lista.php

13

14

15

16

17

18

19

20

21

22

23

eléfordulhat, hogy a HUSZ szerinti km adat a kijarati jelz6kon kiviili tartomdanyba esik, ezért
ilyen esetben a km adatot az oktatdval egyeztetni kell.
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5. abra Allomas, kozépen az allomasi vertex-ekkel (sotétkék)

. A jelz6k km adatait a kiadott [K6zlekedési Hatarozmanyok] 7. tablazata alapjan kell folvenni.
Fontos, hogy a jelz6ket Ggy nevezziik el, ahogy a helyszinrajzokon is megtaladlhatéak!

. A vélték km adatait a kiadott [vonali szint(i adatok] tablazat 07. Allomasi vaganykapcsolatok
munkalapja alapjan kell félvenni.

. A lejtviszonyokat (pontosabban az ezekhez sziikséges pontok km adatait és az élek gradiens
adatait) a kiadott [vonali szintl adatok] tablazat 01. Fligglleges vonalvezetés munkalapja
alapjan kell folvenni.

. Csak a nyiltvonali megalléhelyeknél kell elhelyezni a megallas helyét jel6l6 jelz6ket. Ezeket a
,Stop centre” tipusu jelz8ket az allomasi pontra kell félrakni mindkét irdnybdl. Allomasi
fogaddvaganyokon nem szabad ilyet elhelyezni — akkor sem, ha van peron.

. A fazishatarok km adatait a kiadott [fazishatarok] tablazat alapjan kell félvenni. A fazishatar
pontja el6tt és utan 50-50 m-re egy-egy fémegszakité BE/KI jelzét kell kihelyezni.

. A palyasebességeket és az allandé lassujeleket a kiadott [allandd lassujelek] tablazat alapjan
kell félvenni. Az alapértelmezett palyasebességet vegyiik fol minden élhez: kijel6liink mindent
(Ctrl+A), majd szlrink az élekre (Ctrl+E).

. Ezutdn kezdjuk el félvenni a lassujeleket az élekre, itt lehet differencialni vonattipusok kozott.
A lassujel jelz6ket t(izzik ki, hogy lassuk a lassujelek elejét/végét, de a korlatozas értéke ne
legyen kisebb, mint a legnagyobb vonatkategdridara megengedett sebesség. (igy az el6z8
pontban az élen beallitott palyasebesség szerint fognak kdzlekedni a vonatok.)

. Miutan mar minden pont rendelkezik km adattal, kijel6liink mindent (Ctrl+A), majd sz(irlink az
élekre (Ctrl+E), és az,,Inspector” ablakban a,,Cal.” gombra kattintva kiszamoltatjuk valamennyi
él hosszat. Amdvelet a ,,Functions” men(bdl is elérhetd. (Az eredmény a valtoknal is megfelel6
lesz, az 1:9-es hajlasnal nincs érdemi kilonbség a szelvényezés és a tényleges tavolsag kozott.)

. Miutan mar minden pont rendelkezik km adattal, kijel6link mindent (Ctrl+A), majd sz(iriink a
valtdkra, és az , Inspector” ablakban valamennyi valtéhoz folvesziink 3 s allitasi id6t.

. Folvessziik az allomas objektumokat az allomasra és megalléhelyekre, majd kivalasztjuk a
hozzajuk tartozdé nevet. A neveket a kiadott [.stations] fajlbdl olvassa be a program. Az
allomas/megalléhely nevét cimkével is megjelenitjik az objektum mellett a kiadott sablon
szerint. Amennyiben nem létezik még az allomasunk, akkor el&szor létre kell hozni a
,Tools/Station” menUben.

. Az allomasokhoz tartozd elemeket kijeloljik, és hozzarendeljik az allomasi korzethez
(Functions=>Group->Station area) (6. abra).
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6. abra Egy allomasi korzet

24. Folvessziik az vontatasi aldllomas objektumokat a fazishatar mindkét oldalara, vagy ha ilyen

nincs, akkor az dllomas objektum mellé. Az objektumok elnevezése a kiadott [feladatlapon]
szerepel. Az aldllomasok szine: Pantone>NeXT->, Yellow”.
Megjegyzés: Az OpenTrack minden vontatasi alallomast kilon kezel munkalaponként, ezért
nem szabad ugyanazon névvel tébb munkalapon aldllomast létrehozni, mert akkor is egyetlen
fajlba kerilnek a szimulacidés eredmények, viszont minden munkalap felilirja a fajlt. Minden
aldllomason (legalabb) két transzformator talalhatd (T1 és T2), ezek egymastdl flggetlendl
m(ikédnek, az ,alallomas el6tti” fazishataroknal a KP felé a T1, a VP felé a T2 taplal. Minden
munkalapon tehat ennek megfelel6 nevet kell adni az objektumnak, pl. Kistelek-T1-3, Kistelek-
T2-1, Kistelek-T2-2 stb.

25. Az aldllomdsokhoz tartozd elemeket kijeldljik, és hozzarendeljik az aldllomasi korzethez
(Functions>Group—>Power supply). Vigyazat! El6fordulhat, hogy egyes ,elvalasztd”
fazishatdrok nem feltétlendl valasztanak szét semmilyen aldllomast, hanem szakaszolasi,
kapcsolastechnikai célokat szolgdlnak. A kiadott [aldllomdsok.jpg] abran NEM jel6lt
,elvalasztd” fazishataroknak csak egyik oldaldra kell vontatasi aldllomas objektumot rakni, és
minden elem a fazishatar el6tt és utdn is ehhez az aldllomashoz kell, hogy tartozzon a
hozzarendelésnél. Pl. 155-6s vonal (Jaszszentlaszlo FH).

A 23. és 25. pontot csak az infrastruktura épités legutolsé fazisdban végezzik el! Késébbi mddositas
esetén az Uj elemeket szintén csoportositani kell a meglévé elemekkel, ezért inkdbb ezt csak akkor
végezzik el, ha az infrastruktura teljesen kész.

A fenti pontokon végighaladva fel tudtuk venni a programba a pontos infrastrukturat. Célszer( a
,worksheet”-eket ez utan a lépés utan dsszekapcsolni az un. ,,connector vertex”-el. Erre azért is van
szlikség, mert a vaganyutak szerkesztése soran ,Path”-okat csak kijarati jelz6t6l kijarati jelz6ig tudunk
felvenni, igy a vagadnyutak szerkesztésénél sziikséglink lesz a teljes szimuldlni kivant infrastruktdrara.

Lehetdség van egy munkalapon beldl is haszndlni a ,,connector vertex”-eket, ez a vizudlis megjelenitést
segitheti.

Az 6sszekapcsoldsnal a kovetkezéket tartsuk be:

1. A ,connector vertex”-ek mindkét ,worksheet”-en ugyanazzal a km adattal rendelkezzenek.
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2. Jeloljikkia,connector” ikont (szlirke rombusz) a,,Palett”-en, majd kattintsunk a ,vertex” azon
oldaladra, ahol a kapcsolédast Iétre szeretnénk hozni. Ekkor a ,vertex” kapcsolddasi oldala
rombussza valtozik, amelyik beliil fekete szind.

3. Valasszuk ki az ,edge”-t, majd kosslik 6ssze a két munkalapot iranyhelyesen, tehat a kezd6pont
felé es6 munkalaprdl kezdve. Az 6sszekodtés utan a rombuszok kisziirkllnek, ezzel jelezvén azt,
hogy kapcsolddnak egy mdsi munkalappal.

Lehet6ség van minden elem feliratozasara is a ,Function/Labels” mentpont alatt. Amennyiben
sziikséges, barhova el tudunk helyezni ilyen cimkéket.

A szimulacié futtatdsakor a vonatok allomasokon tudnak megjelenni, ezért a vonalon olyan
kezd6pontot kell felvenni, a hol az &tmend vonatok be tudnak lépni. Célszerlien ez a pont a kezd6
allomas paratlan vége (itt nalunk a kezdGponti allomas allomasi ,vertex”-e) és a végpont esetén a
végponti allomas paros vége (itt nalunk a végponti dllomas allomasi ,vertex”-e). Ha nyilt vonalon
szeretnénk, hogy a vonatok belépjenek, akkor a 7. dbra szerint kell eljarni. Fel kell venni egy , kvazi”
allomast egy allomasi ,vertex”-el, amely minkét oldalan térkozjelz6ket kell elhelyezni. A vaganyutak ez
utan az el6z6ekhez hasonldan szerkeszthetdk, azzal a kiilénbséggel, hogy ,Path” keresésnél nem az
,Exit signal to Exit signal” keresést kell hasznalni. Ennek az a hatranya, hogy egy kilép6 vonat esetén
rogton be tud Iépi egy masik vonat, ami a gyakorlatban nem, csak allomason tudna el&fordulni.
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7. dbra Ki/Belépd pont megszerkesztése

A fenti lépéseken végighaladva el tudjuk késziteni a sziikséges infrastrukturat.
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-A vonatok altal bejarando atvonalak

A vaganyutakon fognak kodzlekedni a vonataink, ezért meg kell hatdrozni azokat a vonat vaganyutakat,

amelyek a valésagnak is megfelelnek. Kordabban emlitettiik, hogy a vaganyutaknak t6bb szintje is van,

nézzilk meg, hogyan lehet eljutni az egyszerl (Route) vaganyuttdl a teljes vonatutig (Itinerary).A
vonatok altal bejdrandé utvonalakat az OpenTrack harom szinten kezeli, ezek bedllitasat a kovetkezé
fejezetek ismertetik.

5.1 Route - vaganyutak

A vaganyutak (8. dbra) szerkesztést dllomasonként tudjuk elvégezni, . Nézziik meg, hogyan lehet egy

allomason ezt elvégezni.

1.

Az elkészilt palyankon a vaganyutakat a Functions—>Search/Fetch all Routes menuponttal
tudjuk automatikusan folvenni. Ekkor egyetlen pont se legyen kijel6lve, mert akkor a program
csak ahhoz keresi meg a vaganyutakat. Azoknak a jelz6knek a pontjait, amelyekt6l a program
taldlt vaganyutakat, a program vorossel szinezi be (lasd: 9. abra).

- -1
10 s ) s ) s ] s ] s [ s 0

8. dbra A Route

A korabban automatikusan félvett vagdnyutakat egyesével ellenérizni kell, hogy tényleg
bedllithatdk-e (pl. nem csonkavaganyra futnak-e), illetve helyes-e a hozzarendelt sebesség. Ezt
a jelz6hoz tartozd pontra kattintva, majd a ,,Route Inspector” (Ctrl+3) ablakot elGhivva tudjuk
megtenni. Itt a folvett vaganyutakat a masodik listaablakbdl kivalasztva tudjuk ellenérizni.
Kijarati vaganyutaknal fol kell venni a csokkentett sebességgel bejarandé szakaszokat (Slow
speed zone/Build) — mivel az utolsé valtd utan a vonat mar gyorsithat.

Be kell allitani a megcsuszasi szakaszokat (overlaps — kivalasztdsa a Route ablak tetején). A
megcsuszasba azok az élek tartoznak bele, amelyek a jelz6 utdn <50 m-re vannak. Feltételezve
hogy a kitérék kb. 35/55 m hossziiak (normal/nagysugara kitérék): ha a jelzé és a valté pontja
kozott a tavolsag <85/105 m, akkor a megcsuszasi szakaszba beleesik. Ezt azért nem lehet
szabdlyosan 50 méterre bedllitani, mert a valtdk biztonsagi hatarjelz6jének pontos helye
ismeretlen. A megcsuszasi szakasz a vonat megallasa utan 5 s-mal oldddik, tehat a Default
gombra kattintva megadott név és oldasi id6 megfelel§ lesz. A kivalasztott megcsuszasi
szakaszokat a ,New” gombra kattintva adhatjuk hozza a listdhoz. Ez utdn minden egyes
vaganyuthoz hozza kell adni a megfelel6 megcsuiszasi szakaszt, amennyiben ez sziikséges.

A vaganyut beallitasi id6ket allitsuk be! (Ctrl+A, majd Edit>Subselect Routes, majd ezen a
unkalapon szintén Ctrl+A) Jelfogds/elektronikus berendezésnél a beallitasi idd 2 s, az oldési id6
3s.

Térkozjelz6ktél indulé vaganyutaknal be kell jel6lni a ,,Reserved with Previous Route” opciot,
valamint engedélyezni kell a foglalt szakaszra jaratast 15 km/h sebességgel. Itt a vaganyut
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bedllitasi/oldasi id6k alapértelmezetten jok (0/5 s). Ezt egyesével kell végezni a ,Route
Inspector” ablakban.

Miutdn a kiadott vonalszakaszt folépitettik mind palyds, mind biztositdberendezési
szempontbdl, a tovabbiakban az atlathatésag kedvéért haszndlhatjuk a 100%-0s nézetet és a
segédracsokra sincs mar szlikség.

5.2 Path - utvonalak

A Path dtvonalakhoz mar 6ssze kell flizni az egyesével megszerkesztett dllomasokat. Célszer(i ezt a

|épést kdzvetlendl a palyaszerkesztés utdan megtenni, igy mar a ,Route” keresésnél is megtorténik a

worksheet-ek kdzotti vaganyutkeresés.

1.

3.

Az Osszeflizés utdn a csatlakozdsi pontokon ativel6 vaganyutakat ellenérizni kell. A ,Route”
keresésnél a ,connecto”r-okon keresztil megtérténik ugyan a munkalapok kozotti Route
felvétel, de célszerl ellenérizni is. Ehhez, és a tovabbi Iépésekhez meg kell, hogy legyenek
nyitva a csatlakozo (szomszédos allomashoz tartozé) munkalapok is!

Az allomason automatikusan fol kell venni az Utvonalakat (Functions=>Search all Path (Exit
Signal to Exit Signal)), amelyek kijarati jelz6t6l kijarati jelzGig fognak tartani. Ekkor egyetlen
pont se legyen kijelélve, mert akkor a program csak ahhoz keresi meg az uUtvonalakat.
Kétvaganyu pdlya esetén két utvonalunk is lesz (a masodik ,,.1” kiegészitéssel). Az automatikus
kiegészitések torlendék, helyettiik , _helyt” kiegészitéssel jeloljik a helytelen vaganyon haladd
utvonalakat. Azokat az Utvonalakat, amelyek atmend f6vaganyrdl indulnak és oda is érkeznek,
azoknak az elnevezését célszerlien egy tovabbi _atm kiegészitéssel jeloljik meg! (Csak dtmend
févdgdnyhoz tartozo kijarati jelz6nél, és csak egyetlen ilyen Utvonal lesz.) Azoknak a jelz6knek
a pontjait, amelyektdl a program talalt Utvonalakat, azokat zolddel szinezi be ( 9. abra).
Ellenérizziik le valamennyi Utvonalat! Jeldljik be a ,,Show Path” opciét!

Be és kilépés esetén is keressiink Path Utvonalakat, de itt ne hasznaljuk az ,Exit Signal to Exit Signal”

opciot.

Ha végeztiink, mentsiik el a kész dllomdasokat.
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9. dbra Egy kész infrastruktura Route és Path Utvonalakkal, példa



5.3 Itinerary - menetvonalak)

A menetvonalak felvételéhez Ossze kell flizni az imént mddositott, egyesével mentett Utvonalakat.

Nyissuk meg a teljes vonalat ,Document Set”-ként.
A menetvonalak felvétele manudlisan torténik, ehhez meg kell nyitni az Itinerary ablakot
(Tools—>ltinerary), és pipaljuk be a ,,Show Itinerary” jelol6négyzetet.

3. A, New” gombra kattintva tudunk felvenni Uj menetvonalakat, ezért az els6 ,,Path”-tél kezd6dGen
sorban vegytik fel a bejarando Utvonalat.

4. A program csak folytonosan engedi az Utvonalakat dsszef(izni, mindig olyan utvonalat ajanl fol
az alsé ablakban, ami az el6z6nek a folytatasa. Itt azokat is felkinalja, amelyek a vagany masik
kijarati jelzGjét6l indulnak, igy lehetGség van irdnyvaltasra is. Ha az alsé ablakban a megfelel6
utvonalat kivalasztottuk, akkor dupla kattintdssal az a menetvonalhoz hozzdadddik, és a
kovetkez6 lehetséges Utvonalakat kindlja fel a program. Ha kész, az ,,0K” gombbal tudunk
nyugtazni.

5. A menetvonalak mentése a ,Save DB” paranccsal torténik.

A menetvonalak felvételét alaposan gondoljuk at! A gyakorlatban — egy hosszu vonalszakaszon, amely
akar tobb 100 km hosszu is lehet — nagyon kevés olyan vonat van, amely pontosan ugyanazt a
menetvonalat jarja be (minden vdganyutja megegyezik). llyen a leggyakrabban az itemes menetrend(
vonalakon szokott el6fordulni, de ott sem biztos, hiszen tehervonatok kozlekedése, a csatlakozasok
nem minden esetben egyeznek meg. A pontos menetvonalak megadllapitasahoz ismerni kell
valamennyi dllomas lizemi tervét, hiszen igy tudni lehet, hogy mely vonatoknak mely vaganyokra kell
érkeznilik. Ezek az adatok altaldban nem allnak rendelkezésre, de egy-egy kisdllomds esetén
elképzelhetd, hogy igen, raaddsul nagyszdmu vonat esetén ez nagyon idGigényes feladat. Alapesetben
tehat feltételezziik, hogy a vonatok mindig a legkedvez6bb Utvonalat fogjak bejarni (az az utvonal,
folyamatosan az atmené févaganyokon kozlekednek. Ezt a szimulacié lefuttatasakor figyelembe kell
venni, hiszen a valés menetrendtdl el kell térni! (A vonalszakaszon nem végighaladé jarm(vek esetén
mas menetvonalak bedllitasa sziikséges.)

Egy vonat menetvonaldnak meghatarozasakor nem csak egyetlen menetvonalat kell megszerkeszteni,
hiszen el6fordulhat, hogy valamely okndl fogva egy dllomdson vagy egy allomaskdzben a masik
vaganyon kell, hogy a vonat kozlekedjen. Ezért egy vonathoz tobb menetvonalat is hozza kell rendelni
menetvonali prioritaskezeléssel, igy ,Deadlock” helyzet kevésbé valdszind, hogy el6 fog tudni fordulni.

A menetvonalak meghatarozasara és a menetvonali prioritasezelésre — a fentiek figyelembe vételével
— a kovetkezdt javasoljuk:

1. Vegylk fel azokat az ,Itinerary”-ket, amelyik csak az atmené vaganyokat haszndljak. Ezek
lesznek a mindenkor az elsé prioritasu Utvonalak (mindkét iranyba).

2. Vegyik fel azokat az Utvonalakat, amely minden esetben a masodik (kitéré irdnyu) vaganyokat
hasznaljak az dllomasokon. Ezek lesznek a mindenkor a masodik prioritasu Gtvonalak (mindkét
iranyba). A masodik itt nem a vaganyszamot, hanem a topoldgia szerinti masodik szamu
utvonalat jelenti.

3. Hasonldan az elGbbiekhez, definidlhatjuk a harmadik, negyedik, stb. prioritasu utvonalakat.



Lehetdség van egy mar korabban létrehozott menetvonal mddositasara is. Ezt célszerl akkor
megtenni, ha olyan menetvonalat kivanunk létrehozni, amely csak nagyon kis mértékben kilonbozik
egy, mar korabban létrehozott menetvonaltdl.

Ilyenkor a kovetkez6ket kell tenni:

Jeloljik ki a médositani kivant menetvonalat.
A ,Duplicate” gombra kattintva masoljuk, ezdltal egy Uj menetvonal fog létrejonni, , CopyOf”
el6taggal. Jeloljuk ki ezt, majd az ,,Edit” gombbal szerkessziik.

3. Nevezzlk at az utvonal nevét.

4. Jeloljik ki azt a két (vagy tobb) egymdst kovetd utvonalat a ,Shift” gomb lenyomdsaval, majd
nyomjunk a ,Replace” gombra. Mddositas esetén mindig paros darabszamu uUtvonalat kell
helyettesiteni, hiszen ha egy allomason egy mdsik vdganyra fog a vonat bejarni, akkor az
mindjart két Utvonalat megvaltozasat fogja jelenteni, mert legaldbb 1 kijarati jelz6 az
utvonalba esik.

5. Az elG6reugro ablakban jeloljik ki az 4j dtvonalakat, majd az ,,OK” gomb kétszeri lenyomasa
utan mentsik az adatbazist a ,,Save DB” paranccsal.

Fontos, hogy a program az els6é prioritasi menetvonalon fogja a vonatukat lekozlekedtetni. Ha
valamilyen akadalyba Utkozik, akkor automatikusan a mdasodik prioritdsi menetvonalra all at. A
madsodik prioritasi menetvonalrél az elsé lehetséges alkalommal vissza fog térni az els6 prioritdsura.
Ez egy Osszetettebb hierarchia esetén is igaz, tehat mindig tud lépkedni a bedllitott prioritasu
menetvonalak szamatdl fliggben, de a cél az, hogy az elsé prioritasi menetvonalon kozlekedjen. Ezért
fontos az is, hogy a menetvonalaknak olyan nevet adjunk, amelyek segitségével azok kdénnyen
azonosithatdak, és a nevik tartalommal bir a felhasznalo felé. Egy O6sszetett halézaton nagyon sok
(praktikusan akar tobb szaz) menetvonal is lehetséges, de célszer( térekedni a minimumral A
menetvonalak felvételével nagyban el lehet térni a valds alaphelyzett6l (minden vonat menetrend
szerin kozlekedik, nincs késés) mivel a valds izemi terveket altaldban nem ismerjiik, ezért a szimulacié
sem a valds képet fogja mutatni.
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-A vonatok lekozlekedtetése

6.1 Train Categories - a vonatok prioritaskezelése

Miel6tt definidljuk a szerelvényeket, meg kell adnunk azt, hogy milyen kézleked6 vonatkategoridink
lesznek, és ezeknek milyen lesz az egymashoz képesti prioritasa (dispatching priority — iranyitasi
prioritds). Ez azt jelenti, hogy egy magasabb prioritasi vonat (IC, EC) els6bbséget fog kapni egy
alacsonyabb prioritdsi vonattal szemben (személyvonat, tehervonat). Ezeket a kategdridkat
kozvetlenll egy adott szerelvényhez rendeljiik hozza, amikor azt l1étrehozzuk. El6fordulhat, hogy egy
ugyanolyan 6sszeallitasu szerelvény kozlekedhet IC és személyvonati kategéridban is (Magyarorszagon
erre szamos példa van) ezért el6fordulhat, hogy egy ugyanolyan 6sszeadllitasd vonatot kétszer kell majd
|étrehozni (lasd kévetkez6 fejezet) annyi kiilonbséggel, hogy egyszer az egyik, masodszorra pedig masik
vonatkategdridba fog beletartozni. A program hasznalatakor célszer(i 5 kategdriat megkilonboztetni:
IC/EC, gyors, sebes, személy és tehervonatokat. (Tehervonatokat a feladatban nem definidlunk, hiszen
azokrol nincs elérhetd adatunk.) Nézziik meg, hogyan lehet egy ilyen kategériat létrehozni, és mely
tulajdonsagokat sziikséges beallitani.

1. Nyissuk meg a Train Categories ablakot (Tools=>Train Categories), itt lathatjuk, hogy
alapértelmezettként 3 vonatkategdria van bedllitva.

2. Valasszuk ki a szerkeszteni kivant kategoriat (kattintsunk ra a bal felsé ablakban), dupla
kattintassal a kategdria atnevezhet6, a jobb alsé sarokban a kategéria szine is beallithaté.

3. A masodik ablakban adjuk meg a kategdria prioritasat (dispatching priority)!

4. Ha kevés kategériank van, akkor a ,,New” gombra kattintva egy Uj kategdriat fog a program a
mar meglév6khoz hozzaadni, amely hozzaadas utan a tobbihez hasonléd mdédon szerkeszthet6.

5. Lehet8ség van definialni az un. ,Look Ahead Zone”-t, azaz azt a tavolsagot/id6t, amig a vonat
el6re 1at. Ez azt jelenti, hogy egy magasabb prioritasu vonat ,el6rébb” [athat, azaz az utjaban
|év6 személyvonatot mar ilyen tavolsagbdl észreveszi a program, és félreallitja. Mds szdéval, ha
egy alacsony prioritasu vonat késik, akkor egy magas prioritdsu vonat miatt (amely el6re lat) a
keresztezések el6bb athelyezésre kerllnek, amelynek kovetkeztében az alacsonyabb
prioritasu vonat még tébbet, mig a magas prioritdsu vonat nem, vagy nagyon keveset fog késni
az alacsonyabb prioritasi vonat késésének kovetkeztében. Célszer(i az IC/EC és
gyorsvonatoknadl beallitani egy megfelel6 tavolsagot vagy id6t.

6.2 Mozdonyok és szerelvények

A tanszéknek mar van egy KJIT.depot file-ja, melyben tébb hazai jarm( is megtaldlhaté. Amennyiben
sziikséges, a jarm(ivek adatai a Tools>Engines meniben megtaldlhatok, és szikség esetén
madosithatdak. A Preferences meniiben ezt a KJIT.depot file-t kell beallitani. A jarm(ivek legfontosabb
paramétere a vonderddiagram, amely a szimulacidhoz sziikséges differencidlegyenletek bemend
paramétere. A file tobb magyar tipus mellett svajci és osztrak jarmdveket tartalmaz. A szimulaciékhoz
a V43-as sorozatu és 1047-es sorozati mozdonyok és a FLIRT ill. Desiro motorvonatok rendelkezésre
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allnak, azok adatain mddositani nem sziikséges. Fontos, hogy mindenki ugyanebben a .depot file-ban
dolgozzon. Uj vontatéjarm(vek az ismert vonderé diagramjuk és mas miszaki adataik ismeretében a
vonder( diagram szerkesztéssel Iétrehozhatdk, amennyiben sziikséges - 10. abra.

r -
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10. dbra A 1047-es sorozatu vontatdjarm( és annak vonderd diagramja
.z ” . . . 2 . . 20
A jarmdvek adatai - kivéve vonoerd diagram - elérhet6ek a

http://www.mav.hu/res/mt 2 vpe 070708 v1 00.pdf oldalon. Uj jarmivek felvétele a vonderd
diagram pontos ismerete nélkil nem lehetséges, de a legtébbszor sajnos nem all rendelkezésre, igy
annak beszerzése idGigényes feladat.

1. Nyissuk mega Tools—>Engines men(t. Itt a fels6 gordiil6 menubdl kivélasztva tudjuk a meglévé
jarmiveinket kivalasztani, azok adatait megtekinteni, és sziikség esetén szerkeszteni. Uj jarmd
felvételéhez a kattintsunk a ,,New” gombra. A meniivel egyltt a vonderd diagram ablak is
megjelenik.

2. Vegyik fel a vonderd gorbe toréspontjait, az egyenesek és a hiperbolak segitségével.
Kattintsuk a vonder6 gorbén az egérmutatéra, majd balrél jobbra haladjunk végig a
toréspontokon. A toéréspont kijelolésével az Engines meniiben a toréspont adatai
szerkeszthet6ek. Az egyes pontok szerkesztése utan a ,Set Data” gombra nyomva tudjuk
érvényesiteni a vonderd gorbe valtoztatasat.

4. Tobb féle lehetéséglink is van a jarm{ mdszaki dllapotdnak figyelembe vételére. A Bad, Normal
és Good gorbék az adhézid hatasfokat jelzik. A gorbéket lehet mddositani. Magyarorszagon
egy V43-as esetén késSbb célszer(i a Bad gérbét hasznalni, mig egy Uj jarm(, vagy egy FLIRT
esetén a normal gorbe is j6. Ezeket a gorbéket itt tudjuk meghatdrozni, de azt, hogy egy adott
vonatszamon kozlekedd szerelvény a Bad, Normal vagy a Good gorbén kozlekedik, csak késébb
kell bedllitani. Ezeknek a gérbéknek a haszndlata opciondlis, de hasznalatuk célszerd.

5. Adjuk meg a vontatojarmd tovabbi paramétereit is, mégpedig a tomeg (Load), hossz (Length)
és aramellatasi rendszer adatokat! Az ,,Adh. Load” megegyezik a ,Load”-al. Tébb aramellatasi

rendszer is kijel6lhetd, a rendszer mellett, a jobb oldal bepipalasaval.
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6. Mentsiik el a depot file-t, mert csak ekkor jon létre az Uj jarm( —illetve egy jarm{ mddositasa
is csak a mentés utan lesz elérhetd. A .depot file valtoztatasaval annak tartalma mddosul, ezért
célszer( csak egy gépen szerkeszteni azt, és a tobbiek szamdra kés6bb hozzaférhetévé tenni.
igy egy kozos .depot file-lesz, ami a KJIT.depot file, ezért amennyiben mddositani szeretnénk
azt, csak egy gépen tegylik meg. Az 6t féle vontatéjarm(i azonban altaldnos szimuldciékhoz
elegendd. Ha mégis szeretnénk Uj jarmUveket felvenni, akkor mindenki mas szdmdra az Uj
KJIT.depot file-t elérhet6vé kell tenni.

A szerelvények Osszedllitdsa hasonléd mdédon torténik. Fontos, hogy csak olyan szerelvényeket tudunk
|étrehozni, amelyek vontatdjarmive a .depot fajlban rendelkezésre all. Ez forditva is igaz, tehat ha
olyan, mas helyrél szarmazd .trains fajlunk van, amelyben lévé vontatdjarmliveket a sajat .depot
fajlunk nem tartalmazza, akkor a szimulacié sem fog mdkodni, ezért a két fdjlnak egymassal
konzisztensnek kell lennie. Hasonldan a .depot file-hoz itt is célszerl egy .trains file-al dolgozni, csak
egy gépen modositani, és ezt a file-t a tobbi felhaszndléval megosztani. Amennyiben sziikséges,
|étrehozhatunk és szerkeszthetiink szerelvényeket.

1. Nyissuk meg a Szerelvények ablakot (Tools=>Trains (Ctrl+6)). A panel fels6 részében lathatjuk
feketével azokat a meglévé szerelvényeket, amelyek vontatdjarmiveit a .depot fajl
tartalmazza. Sziirkével vannak jeldlve azok a szerelvények, amelyek vontatéjarmf(iveit a .depot
fajl nem tartalmazza, de a .trains fajl igen. Egy adott szerelvényre kattintva annak legfontosabb
adatai megjelennek. Ezt szerkeszteni az ,Edit” gomb megnyomdsaval tudjuk. Uj szerelvény
felvétele a ,New” gombra vald kattintdssal lehetséges.

2. Adjuk meg a szerelvény nevét és kategdriajat (dispatching category).

Az Engines listaablakban az , Add” gombra kattintva tudjuk a meglévé .depot fajlbdl a
vontatdjarml(ivet (jarm(iveket) kivalasztani.

4. A ,Trailers” listaablakban lehet a vontatott jarmdveket felvenni, szintén az ,,Add” gombra
kattintva. Itt szlikséges minden kocsi tomegének (Load) és hosszdnak (Length) megaddsa. A
szerelvény hosszat és tomegét a program automatikusan kiszamolja.

5. Lehet8ség van kulonbozé légellendllasi formuldk meghatarozasara, de a ,Strahl/Sauthoff
Formula” megfelel6 szamunkra.

6. LehetGségvan gyorsitasi/fékezési adatok elvételére is, de az alapbeallitisok is megfelelGek, igy
ezekkel most nem foglalkozunk.

7. Ha a szerelvény kész, akkor az OK gombra kattintva tudjuk azt |étrehozni, és ezzel a ,, Trains”
ablakban is meg fog jelenni.

Lehetdség van mar meglévé szerelvény alapjan udjat létrehozni.

1. lJeloljik ki az alapszerelvényt, majd kattintsunk a ,Duplicate” gombra. Ekkor lesz egy Uj
szerelvénylink, amelynek neve el6tt megjelenik a ,,CopyOf” felirat.

2. Ezt a masolatot kijelolve, majd az ,Edit” gombra kattintva a szerelvény a fentiekhez hasonld
maodon szerkeszthetd.

Mivel egy kocsinak csak a tomege és a hossza szamit, ezért nem sziikséges minden egyes kocsi
altipusbdl darabonként Gsszeallitani szerelvényeket, elég csak a 6 tipusokbdl — pl. a By, BDt és Bhv
kocsik f6 paraméterei is megegyeznek —, és e mellett mindegy az is, hogy els6 vagy mdsodosztalyu
kocsik vannak egy adott szerelvényben.
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Amennyiben létrehoztuk valamennyi kozlekedtetni kivant szerelvényt, meg tudjuk hatdrozni a
(vonatszammal rendelkezd) vonatokat és a menetrendet.

6.3 Courses/Services (vonatok)

Az angol ,,course” sz6 magyarra forditasa az altalunk hasznalt értelemben nehézkes. Ha a szdszerinti
forditast nézzik, akkor a palya, kurzus, folyamat szavakat kellene haszndlni. Az OpenTrack
értelmezésében a ,course” nem mads, mint az egy vonatszdmon kozlekedé vonat. Nem kell mast
tenniink, mint hogy a kordbban létrehozott szerelvényhez menetvonalat és vonatszamot rendeliink
hozza, ugyanakkor menetrendet még nem. Kés6bb, a mar meglévé vonatszdmhoz kell majd a
menetrendet megszerkeszteni.

Egy nem atmend vonat esetén célszer(i olyan ,course”-t Osszedllitani, amely sordn az allom3si
tartézkodasa is jelen van. tehat pl. a betétjaratok a betétjarati végallomason ne tlinjenek el, hanem az
Utjukat az érkezé iranyba folyatassak. igy a betétjarati végallomason a vonat allomdsi foglaltsaga
megmarad. Ebben az esetben a vonat azonositéjat célszertien kell megvalasztani.

Nézzik meg, hogyan lehet egy adott vonatszamon kozleked6 vonatot Iétrehozni.

1. Nyissuk meg a Vonatok ablakat (Tools=> Courses/Services), majd kattintsunk a ,,New” gombra.
Adjuk meg a vonat azonositéjat (,,Course ID”), ami a vonatszam legyen. Tetszés szerint leirast
és kommentet is hozza lehet adni, de a vonatszam a legfontosabb.

3. Valasszuk ki a menetvonalakat! Az els6ként kivdlasztott menetvonal automatikusan 1-es
prioritassal, a masodikként kivalasztott menetvonal 2-es prioritassal (és igy tovabb) fog
megjelenni. Lehet6ség van manudlisan a prioritasi sorrenden modositani.

Valasszuk ki a szerelvényt és a sebességtipust (,,Speedtype”) a legordiilé menikbél.

5. A ,Route Reservation/Release” legyen diszkrét, hiszen a vonataink nem mozgdblokkos
rendszerben kozlekednek. (Metrd vagy ETCS L3 palya esetén természetesen a mozgdblokkos
rendszer hasznalata megengedett.)

6. Akét ,Performance” mez6t allitsuk be 90-95% értékekre, de ezt lehet modositani kés6bb is.

7. Megadhatjuk a kezdeti sebességet, ami akkor hasznos, ha nyilt palyan Iép be a vonat. Ha
allomason, és ott meg is all, akkor a kezdeti sebesség legyen 0 km/h. Ez utén az ,,OK” gombra
kattintva létrejon egy vonat.

8. Ha kész a vonat, akkor a ,Courses/Services” ablakban a ,Timetable: First Departure” mezé
mellett kattintsunk a ,,New” gombra, ezzel rogtén el6ugrik a , Timetable” ablak. Egyel6re itt
csak kattintsunk a ,,Save DB” gombra, majd a ,, Timetable” ablakot zarjuk be. A vonatnak kés6bb
fogunk majd menetrendet szerkeszteni.

Ha tobb ugyanolyan vonatot szeretnénk kozlekedtetni ugyanazon a menetvonalon, akkor azt a
,Timetable” ablak fogja kezelni. Ha ugyanazon a menetvonalon, de masik szerelvény Osszeallitassal
szeretnénk vonatokat kozlekedtetni, akkor a ,Courses/Services” ablakban a , Duplicate” gombbal a
menetvonal masolhatd, csak Uj vonat azonositdt és Uj szerelvényt kell megadni.
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6.4 A menetrend

Miel6tt egy vonat menetrendjét megszerkesztenénk, a vonathoz tartoz6 menetrendet el6zéleg

mindenképpen fel kell venni, még akkor is, ha az ires. (Iasd xy fejezet)

Ha a fenti |épéseket megtettiik, akkor szerkessziik meg a vonat menetrendjét!

6.

Nyissuk meg a Menetrend ablakot (Tools—> Timetable).

Az ,Actual Course ID” menipontban a nyilak segitségével valasszuk ki a szerkeszteni kivant
vonatot.

Atablazatot toltsuk ki. Elegendd csak az induldsi id6adatokat megadni ott, ahol a vonat megall.
Megallds esetén a ,Dwell” oszlopba irjuk be a minimalis tartézkodasi id6t masodpercben.
Altaldban 60 masodperc elegendd, de tetszés szerint lehet az értékeket mdédositani. Kis
forgalmd megalléhelyeken 30 mésodperc, dllomdsokon 60 masodperces tartézkodasi idével
célszer(i szamolni. llyenkor a ,,Stop” oszlopban megjelenik egy pipa - 11. dbra.

Ha végeztiink, akkor mentsiik el a menetrendet a ,,Save DB” gombra kattintva.

Utemes menetrend felvételéhez haszndljuk az ablak bal oldalat, itt automatikusan lehet
menetrendet és vonatszamot generaltatni az opcidknak megfelel6en.

Ha valamennyi vonat mentendjét felvettiik, mentsik még egyszer az adatbazist!

Ha a vonat nyilt palyan lép be, akkor is meg kell adni a belépés idejét — ,Departure” — a belép6 ponton!

A pontos menetrend ismerete elény, de sajnos a legtobbszor a tehervonatok menetrendje nem all

rendelkezésre, ezért a szimulacid is hianyos lesz.

A ,Timetable” meniiben tovabbi lehet6ségként a csatlakozasok is beallithatdéak, de ehhez elGszor

valamennyi vonat menetrendjét fel kell venni.

Ha a programban mindent bedllitottunk, van megfelel6 menetrendiink, akkor kezd6dhet a szimulacid

futtatasa.
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+ G530 Siofok 00:05:00 04:10:00 W 0 1=
[~ [&530 | Balaionszépla) HHMM:SS —n o |~ o]
5530 Balatonszépla HH:MM:S5 04:17:00 &0 4 o
- &850 Zamardifelsd HH:MWM:SS 04:20:00 \/ &0 W u}
| | 6530 Zamardi mh.  HH:MM:SS 04:23:00 W B0 W 0
L 8530  Szantod-Kord: HH:MWMSS 04:27:00 W B0 W 0
& 5530 Balatonfdldva HH:MM:S5 04:30:00 v B0 W o
G530 Balatonszarsz HH:MM:SS 04:36:00 v B0 W ]
8530 EBalatonszeme HH:MM:SS 04:4 1:00 v B0 W 0
4 a630 Balatonlelle fe HH:MK:SS 04:47:00 W B0 W ] J I
8530 EBalatonlelle m HH:MM:SS 04:50:00 v B0 W 0
G530 Balatonboglar HH:MM:S3 04:57:00 W B0 W ]
6530  Fonyddligetm HH:MM:SS 05:03:00 v B0 W 0 _|LI
K| 3
Add Rows |Ins.Hows| Del. Riows || Function: Add Stops :l Dravell [3]:| 60 Go |
Course ID | station |Type | Min.Wait | Max. Wait |Join | Spiit| ||
|
el
=M show conn. Cnursel Ins. Cnnnectionl Drel. Connectiu:unl 1
Interval 4 Courses 82 Entries
Course|D: +2 Actual Course ID: | 8530 %
Delta Time: ”_I 01:00:00 Ref Course ID: I
[ Keep Interval References .
Train: W43+7B
rKeep Interval Ref. for Delays I i
¥ Update Courses / Services Train Speedtype: | Személyvanat
Creats || Courses Train Category: | Category 1
|| ¥ Show Operations [T Show Day ¥ Show Use Departure Time
[¥ Show Stationnames [V Show act Data. Adjust | [ Show Distribution Mame
|| [ Show Stops anly ¥ Show Delay Colars [T Show Delta Load
sync. | Delete | Update |saveDB| add | Move | sont | showan | show |

11. abra A menetrend kiszerkesztése, példa
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Blszimulacié és kiértékelés

A szimulacid futtatdsa el6tt be kell allitani néhany tulajdonsagot.

Nyissuk meg a Szimulacié ablakot (Tools—>Simulation).

A fels6 legordil6 menibdél valasszuk ki az , Output”-ot. Itt megjelennek azok a kimenetek,
amelyek a szimuldcio futtatdsa utan az el6z6leg a ,,Preferences” meniben beallitott OTOutput
mappaba fognak irddni. Jeloljik be az 6sszes lehetGséget, és ellendrizziik le, hogy folyamatos
gorbéket és metrikus mértékrendszert fog-e hasznalni a program.

3. Ha ezzel végeztiink, akkor a legordiilé meni segitségével térjlink vissza a ,Simulation” filre.

4. A szimuldcio értékeléséhez fontos, hogy a program kirajzolja a vonatok menetgrafikonjat. Ezt
még a szimuldcid lefutdsa eldtt be kell allitani. Ennek lépései:

a. Nyissuk meg a Menetgrafikon ablakot (Tools=>Train Diagram).

Az ,Operations” legordiil6 mentibél vélasszuk ki a ,,New Corridor” opciét.
Hasonldéan a menetvonalak szerkesztéséhez, vegyiik fel az dbrazolni kivant dtvonalat
a kezd6ponttdl a végpont felé haladva.

d. Ha az utvonalat felvettiik, a ,New” gombra kattintva mentsiik el a menetgrafikont
(.oscimor lesz a kiterjesztése). Ezutan az , Operations” legordiilé meniibél az ,,Open
Document” opciét kivalasztva a menetgrafikon barmikor megnyithato.

e. A Menetgrafikon ablakban lehet6ség van a grafikon tulajdonsdgainak bedllitasara.
Célszerl valamennyi — kivéve a ,Flip Axes” — paraméter felvétele, de tetszés szerint
lehet azokat beallitani (12. dbra). A menetgrafikon a szimulacié futdsa alatt legyen
megnyitval!

f. A megfelel6 bedllitasok utan az ,Operations” meniben a,,Save Document” paranccsal
mentsik el a dokumentumot.

5. Allitsuk be a szimuldlni kivant id&intervallumot (,Start Time” és ,Stop Time”), valamint a
szimulacio lefolydsanak gyorsasagat (,,Step”).

6. Es6sid6 szimulacidja esetén lehetdség van a tapadasi tényezd megvaltoztatdsara is (,,Adhesion
Outside” és ,Adhesion Tunnel”). A ,good” érték alapvetéen elfogadhatd.

7. Inditsuk el a szimulaciét a ,play” gombbal. A szimuldcid nyomon kovethet, tetszés szerint
megallithaté. A szimulacid [épéskdze (Step) a szimulacid kdzben is megvéltoztathatéd. Ha a
|épéskdzhoz tartozd legordiilé gombra kattintunk, a szimulacié megall, és a legordilé listabadl
kivalasztott Iépéskozzel fut tovabb. Ha kivanjuk, akkor a ,Messages” bepipaldsaval a szimulacio
soran folyamatosan lizeneteket is kapunk az aktualis torténésekrdl. Ez késébb segithet a hibak
feltarasaban.

27.



Ki_Be_Aliga - Ki_Be Bélatelep

04.00 a0 20 k] a0 50 05.00 10 20
Ki_Be_Aliga oo | L e e e e e B e T T T T T T T T T L
Balatoralige z4 |l Train Diagram LJ
Balaternildons mh. 51 [oCHITE
File:  traingraph 1 otsimcar =
Seabarisisti s
s Corridar
Szabadlifirda mh. 1.7 v KLBE AL oo i‘
st o E 7 by o
. - v Builagos 5.1
&, + Szabadis ag ¥
Balatonzzéplak ®lzdmh. 128
i , Title:  [Ki_Be_aliga- Ki_Be_B
Balatonszéplak alsh mh. 206 e
Zamard flst 22z om-
Zamired mh. sag Train Categories
W Category 1
' Category 2
Szantid- Kerteheoy 288 11 v Category 3 .J
Balatonfiicvar mh 305
Time Slat
[ Joaon -[ [osoo = »
Balatoriszdrazil 343 | "
Options
[¥ Full Stationname
Salats N [¥ Kilometration Metric 3
alnszemes a8 [¥ Planned Timetable
¥ Route Occupation Both %
¥ 5chematic Function
Balatorlelle felsd 4az | ¥ Course ID
Balaterilelle mh. 464 [¥ Course Description
¥ Single Track Sections
. [ Legend
Balatonboglar 504 ] ¥ Conflicts
[T Flip &xes
¥ Owenwrite Data
Foriidicetmh 551 [ PlotOnling  Every Step 3
Foryid ser || Course ID:
B 0%
APt R en E% | ‘ t : ¢ L ¢ : :
0400 10 20 30 40 50 05.00 10 20
Legand Catagory 1 Braking for Route
Category 2 Braking for Signal
— Category 2 Braking for Approach fepact

12. abra Egy el6készitett menetgrafikon

A szimulacié lefuttatdsa utan vizsgéalhatjuk a kirajzolt menetgrafikon (13. dbra). Az dbran a tervezett
menetvonalra kattintva el6ugrik a vonat menetrendje is. Az dbran feketével latszédik a tervezett és a
vonat kategéridhoz rendelt szinnel a tényeleges menetvonal. J6l lathatd a példaban, hogy a tervezett
és tényleges adatok kozdtt jelentds eltérés van. Erdemes ilyenkor végigellendrizi, hogy mindenhol

megfelel6-e a palyasebesség.

Stop at Signal
Late erival
Late Depatture
Late Passing

28.



Ki_Be_Aliga - Ki_Be Bélatelep

04.00 a0 20 30 A0 50 0500 1 20 30
Ki_Be _Aliga DD‘......... L e e e e e B e e I s I e e o e e e T I LA B e e e e e e e B B B I e B L S B B B B o e LI S S B B B B o e e e
Balatrialicn 24 |
Balatordlagos mh. 51 —
Seabarlislsti EE
Szahadifirco mh. 1.7
e e ||
\’om
Balatcnszéplak Blsimh. 186
Balatonzzéplak alsd mh. 208 /6
Zamard felad a2z || h
Zarnidred mb. 248
Szdntich Kirdsheoy ==X
Balatoeitichar mh 30.5
Balatnszérszi a4s &
Balatonszemes 396 Il &
P -
Balatorilelle folsd 4az || o A Timetable —
Balatonlelle mh 464 = = =
el m course ID | Station [| Arrival || peparture | use [ Dwell | stop[|M. Del | |
+ 8530 Sibfok  00:05:00  HH:MRSS 04:10:00  04:10:00 v B0 v 0 -
o m— s || 8530 Balatons HH:MM:SS D4:13:16  04:14:00  04:14:16 v B0 von y
8530 Balatons HH:MM:S3 04:16:39  04:17:00  04:17:39 v B0 v 0
8530 Zamardi HH:MM:SS 04:19:42  04:20:00  04:20:42 v B0 W 0
. 8530 Zamardi HH:MM:5S 04:23.20 04:2300 042420 v B0 v 0
Foryidigetmh. s 8530 Szanthd- HH:MMSS 042830  p4e7on  [042880 | ~ 60 v oo 1
Forvia f 8530 Balatonfi HH:MM:S5S 04:31:33  04:30:00 |04:32:33 v B0 von
577 =
o Il & J3530 Balatons HH:MM:SS 04:37:32 043600 D4id@sz’] v so v 0 f
" el
RERERR e, sl t t ; ; t f : L L
- 04.00 a0 20 20 A0 =0 0s.00 Add Rows ‘Ims HowleeI Hawsl Function: Add Stops % | Dwell [3] E0  Go 3
ogand —_— g o et CourseID  [Station [Type  [Min.Wait |Max. Wait [Join [spit] | j
Category 2 Braking for Signal
—  Category 3 o Braking for épproach Aspect
5 Stopat Signal
o Late frrival d
o Late Depa.m.lve Show Conn. Course | Ins. Connection | Del. Connection
o Late Passing
Intrryal 4 Cnursps A7 Frfries

13. dbra A menetgrafikon a szimulacid lefutasa utan




A szimuldcio lefuttatasa utan a ,Timetable” ablakot el6hivva megjelennek a szimuldciébeli tényleges

indulasi id6adatok (14. abra). Példankban jél megfigyelhetd, hogy a vonat azért indult késve — akkor is,

ha idében érkezett —, mert az dllomasi tartdzkodasi idé sok.

H

H

Timetable - J' =
| Cours | Station  [[arival | | Departure | use | Dwell [Stop ||| M. Del. | ]
5509 Bélatelepmh. HHMMSS 0441:57 044300 044300 +  EBD W 0 ﬂ
5509 Fonyod HH:MM:SS 0446:22  04:47.00 044722 +  EBD W 0
5508 Fonyadligetm HH:MM:SS 04:50:28  04:51:00  04:51:29 w BD W il
3508  Balatonboglar HH:MM:SS 04:56:48  04:57:.00 |04:58:03 + BD W i
8509 Balatonlelle m HH:MRSS 050142 05:02:.00 050242 + BD W i
8509 Balatonlelle fe HH:MKSS 05:05:31 05:05:00 |05:06:31 + B0 W i
8509 Balatonszeme HH:MMKSS 05:12:01  05:11:00 051301 +  EBD W i
8509 Balatonszdrsz HH:MRKGSS 05:17:05  05:17:.00 051805 +  EBD W i
8509 Balatonfildvd HH:MRSS 05:22:35  05:23:00 05:23:35 + BD W i
55098 Szantod-kKord: HH:MM:SS 05:25:51 05:26:00 052651 v B0 W i
8509  Zamardimh.  HHMK:S5 05:30:24  05:31:00 053124 + D W i
8509  Zamardifelsd HHMMSS 05:34:17 053400 053517 + O W i
5509 Balatonszépla HHMMSS 053640  05:37.00 053740 +  EBD W 0
5509 Balatonszépls HH:MMSS 05:39:52 05:40.00 054052 +  EBD W 0
&509  Sidfok HH:MR:SS 054355 054500 054500 w BD W il

[ 8509  Sidfokteher  HH:MKSS HHMMSS HH:MMSS 05:45:32 W 0 P i
8509 Szabadifirdo HH:MRSS 054820  05:50:00 05:50:00 + B0 W i

i 5509  Szabadisdsth HH:MM:SS 05:52:32 05:53:.00  05:53:32 v B0 W i I
3509 Balatonvildgo HH:MR:SS 055718 05:58:00  05:53:18 v B0 W i [ i

i Jasug Balatonaliga. HH:MM:S5 06:05:48  05:02:00 |DB:06:48 + BD W i Jﬂ

I Addd Rows |In3.H0w3| Del. H0w3| Function: Add Stops + | Dwell [5]: ’—E.D ﬂ

! | course D |Station [Type  [Min.wait | Max. wait [Jon [spit] | j

B

Show Conn. Coursel Ins. Cannection | Del. Connection

Caurze |D:

Delta Time

Train: 1047+5Byee
¥ Keep Interval Ref. for Delays i | i
W Update Courses / Services Train Speediype: |Szemé|yv0nat
Create 1 Courses Train Category: | Category 1
[¥ Show Operations [ Show Day ¥ Show Use Departure Time
[¥ Show Stationnames [¥ Show act Data Adiust | [T Show Distribution Name
[ Show Stops only ¥ Show Delay Colors [ Show Delta Load !

:ﬂl—m Ref. Course |D: |

¥ Keep Interval Referances

Interval 4 Courses §2 Entries

+ 2 5

&ctual Course ID: | 8509

|« B

sync.| Delete | Update [save| aan | wmove | son | snowen | show |

T

14. dbra A 8509-es szamu vonat tervezett és tényleges id6adatai

A szimuldcid lefuttatasa utan szamos grafikon jelenitheté meg. Nézziik meg, hogyan lehet egy

diagramot megjeleniteni.

1.

Nyissunk meg egy lres munkalapot, majd nagyitsuk ki teljes képernyé6re. Kattintsunk a

,Palette” eszkoztér legalsd ikonjara, majd a bal egérgomb nyomva tartasaval rajzoljunk egy —

célszer(ien a teljes képernyGt betoltd — Gres diagramot.

Az eszkoztdron az egérmutatdra, majd a megrajzolt diagramra kattintva eléugrik az ,,Inspector

— Plot” ablak. Itt az ,,Add” gomb lenyomasa utdn megjelenik az ,Add Plot” ablak, ahol

kivalaszthatjuk azt a vonatot, amelyet abrazolni szeretnénk. Ezutan a ,Type of Diagram”

legodrdilé meniibdl vélasszuk ki a kivant diagram tipusat.



3. Ezutan kattintsunk az ,,OK” gombra, és a kivant diagram megjelenik a képernyén. A diagramon
tovabbi szerkesztési, megjelenitési lehetGségek is rendelkezésre allnak.

4. Ha tovabbi abrat szeretnénk ugyanebbe a diagramba berajzolni, akkor az ,Add” gombbal ezt
megtehetjlik.

Valamennyi diagram munkalapként elmenthet§, ha kés6bb ezek az adatok kellenének, akkor
egyszerlien meg lehet Gket nyitni. S6t, ,Document Set”-ként a vonallal egyiitt is menthet6ek.

A munkalapon a nagyitas funkcié hasznalhaté, ha az dbra tul s(ir(i és nehezen olvashato, akkor célszer(
lehet nagyitani rajta.

Lehet6ség van a menetrend Excel tabldzatban torténd megjelenitésére is, ezt Ugy kaphatjuk meg, ha a
diagram tipusara ,Timetable (text)” formatumot adunk meg. Ekkor automatikusan elindul az Excel, és
a kivant vonat (vonatok) menetrendje egy Excel tablazatban megjelenitésre kerdl.

Tovabbi hasznos megjelenités az dllomasi vaganyok foglaltsaganak kirajzoltatasa. Ennek megjelenitése
mar bonyolultabb feladat.

1. Nyissuk meg a Szimulacio ablakot (Tools=> Simulation).

A felsé legordilé menibdl valasszuk ki az ,,Output”-ot. Az ablak alsé részén, az ,,Occupation
(Used: 0)” cimke alatt talalhatok a vaganyfoglaltsagi diagrammal kapcsolatos beadllitasok. Ide
el6z6leg fel kell venni azokat a vaganyszakaszokat, amelyek foglaltsagat a szimulacidé utdn ki
szeretnénk rajzoltatni.

3. Egy vagdanyszakasz felvételéhez jel6ljik ki a két kijarati jelz6 kozotti valamennyi élet, majd
nyomjunk az ,Add” gombra a ,Simulation” ablakban. Ezzel ez a szakasz a listdban megjelenik,
ahol célszer(i dtnevezni. Atnevezni a szakasz nevére valé dupla kattintassal lehetséges.

4. Vegylik fel ily médon valamennyi szakaszt! A szakaszok felvétele utan futtassuk le djra a
szimulaciot!

5. Vegylnk fel egy 4j ,, Train Graph” lapot.

6. Az ,Add” gomb segitségével térjlink at az ,Add Plot” ablakra, és valasszuk ki az ,,Occupation
Diagram” tipust, majd nyomjunk az ,,OK” gombra. Ez utdn megjelenik az ,,Add Occupation”
ablak, ahol a Shift gomb segitségével jel6ljik ki valamennyi dbrazolni kivant vaganyszakaszt,
majd nyomjunk az ,0K” gombra. A foglaltsagok megjelennek a diagramon (16. abra).

Nagyon sok fontos informaciét tartalmaz az output fajlok kézott az OT_Physic fajl az OTOutput
mappaban. Ez a fajl Excel tablazatként megnyithaté, és benne minden vonathoz megtaldlhatdak az id6,
tavolsag, sebesség stb. adatok - 17. dbra. Ez a legnagyobb kimeneti fajl a szimulacié utan. Késébbi
feldolgozasra az Excel tablazatbeli adatok alkalmasak.
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15. dbra A 859-es szamu vonat ,,Speed/Distance+Stations” diagramja
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16. abra A foglaltsagi adatok, példa

33.



O e o B W R e

=
o

-
=

-
%]

A B C D E F G H I J K L M M
7
// File: C:\Users\PISTA\Dropbox\Egyetem\Open Track\OT adatbazis\OT Aliga-Bélaptelep\OTOutput/OT_Physic.tsvP
1/
/{ Produced by OpenTrack: Thu Aug 21 13:59:34 2014
/{ Time/Distance/Speed/Acceleration/TractEffort/Resistance/Mech. Power/Power In/Energy In/Power Supply of all the Courses
/{ Type :0T _Text
/{ Desc. :OT_tsvP
/{ Scenario: Adh. Outside: good / Adh. Tunnel: good / Delay: none / Global Perf.: 100.0 % / Step: 1.0 5/ Time: 03:50:00 - 08:00:00
/f Col. 0: Course-1D
/f Col. 1: Time [s]

// Col. 2: Distance [km]
/{ Col. 3: Speed [km/h]

3 |// Col. 4: Acceleration [m/s*2]
[/ Col. 5: Tractive Effort [kN]
/[ Col. 6: Resistance [kN]

[/ Col. 7: Mech. Power [kW]
8

J/ Col. 8: Power In [kW]
/{ Col. 9: Energy In [MJ]
// Col.10: Power Supply

/I

8530 13300 0 1] 0 1] 0 1] 0 1]

8530 15000 o 4] o 4] o o o o

8530 15001 0.0002 14 0.396 147 8.3763 58.2053 58.2053 0.0291 Szantod-Kéroshegy -T1-2
8530 15002 0.0008 2.9 0.396 147 8.4338 58.2053 58.2053 0.0873 Szantod-Kéroshegy -T1-2
8530 15003 0.0018 4.3 0.396 147 8.3055 116.3865 116.3865 0.1746 Szantod-Kéroshegy -T1-2
8530 15004 0.0032 5.7 0.395 147 8.3915 174.5376 174.5376 0.3201 Szantod-Kéroshegy -T1-2
8530 15005 0.0049 71 0.395 147 8.6916 232.6526 232.6526 0.5237 Szantod-Koroshegy -T1-2
8530 15006 0.0071 8.5 0.395 147 8.806 290.7255 290.7255 0.7854 Szantod-Kéroshegy -T1-2
8530 15007 0.0097 10 0.394 147 8.9344 348.7504 348.7504 1.1051 Szantod-Kéroshegy -T1-2
8530 15008 0.0127 11.4 0.394 147 9.0771 406.7214 406.7214 1.4828 Szantod-Koroshegy -T1-2
8530 15009 0.016 12.8 0.394 147 9.2338 464.6325 464.6325 1.9185 Szantod-Kéroshegy -T1-2
8530 15010 0.0198 14.2 0.393 147 9.4046 522.4778 5224778 2.4121 Szantod-Kéroshegy -T1-2
8530 15011 0.0239 15.6 0.392 147 9.5894 580.2513 580.2513 2.9634 Szantod-Kéroshegy -T1-2

OT_Physic 4 3

17. abra Az OT_Physic file tartalma




Il Tovibbi lehetdségek

Az el6z6 fejezetekben egy normal, Gzemi koérilményeknek megfelel6 menetrendet szimuldltunk.
Lehetdség van azonban bizonyos foku zavarok és balesetek felvételére is, amellyel vizsgalhatjuk a
balesetek/zavarok hatasat a teljes menetrendre. Hozzéatessziik, hogy adott esetben egy Uj lassujelet
vegylink fel, hiszen ez is okozhat jelent6s menetrendi eltéréseket. A zavarok hatdsanak vizsgdlata
nagyon fontos, hiszen egy egyvdganyu vasutvonalon valamely korlatozdsnak a hatdsai hosszu tavuak is
lehetnek, elég csak a nyari balatoni vasuti menetrendek zavarérzékenységére gondolni.

Tovabbi opcid példaul a vonatok kezdeti késésének bedllitasa, vagyis annak vizsgalata, hogy egy adott
vonat késése milyen hatdssal van a vonal menetrendjére. Ahogy a bevezet6ben elhangzott, a feladat
fogja meghatarozni azt, hogy milyen tovabbi alternativakat tudunk majd a program hasznalataval
megvizsgalni.

Lehet8ség van valamennyi adat exportéalasara/importalasa tébbféle formatumban, amely opcidk a
,Functions” meniiben elérhetéek. Ennek az az oka, hogy egyes orszdgok — pl. Svdjc — mar rendelkeznek
olyan infrastruktura adatbazissal, amelyben az infrastruktura adatok .railml formatumban elérhetGek.
Itt példdul az infrastruktura szerkesztése is automatikusan megtorténhet. Mas részrél két gép kozotti
adatbazis cserét is megkonnyitik ezek a lehetGségek.

Bizunk benne, hogy alap kiinduldsnak ez a segédlet megfelels, és aki még jobban szeretne elmeriilni a
szimulacids program nyujtotta lehetdségek kozott, az ezen segédlet alapjan tovabb tud lépni.

35.



